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Chapter 1

Introduction

Thank you for selecting Rational Rose RealTime, the real-time
industry's leading environment for designing and building real-time
applications.

The Rational Rose RealTime Professional Package you have purchased
extends Rational Rose RealTime to provide support for many
embedded targets. If you do not have the installation key, please
contact License Support for assistance. See “Technical Support” on
page 53.

In this guide:

“PLEASE READ FIRST” on page 2

“What’s New” on page 2

“Overview of the Professional Packages” on page 5
“Referenced Configurations” on page 11
“Installation” on page 23

“Converting Models from Connexis” on page 37
“Troubleshooting and Known Issues” on page 43

“Documentation Updates” on page 51

“Technical Support” on page 53

Please read this guide, along with the Release Notes for the base
product, before you install or use the Rational Rose RealTime
Professional Edition.

Note: In some cases, you may note discrepancies between the printed
documentation and the online documentation. In these cases, the online
documentation is the most up-to-date and should be followed.
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Chapter 1 Introduction

Please visit the Rational Web site for the latest Release Notes, patches
and information:

http://www.rational.com/support/

If you encounter any problems while installing or running Rational
Rose RealTime, please check here first to see if you have encountered
a known problem. If you find a problem that is not yet documented,
please call Rational Customer Service so we can investigate it, provide
you with a workaround, and track the problem for further action.

See “Technical Support” on page 53 for telephone numbers and e-mail
addresses of the Rational Customer Service contacts for your region.

PLEASE READ FIRST

You must install Rose RealTime before installing the Rational Rose
RealTime Professional Package. Directory structures established
during the installation of Rational Rose RealTime are required during
the installation of the Rational Rose RealTime Professional Package.

Please review the Rational Rose RealTime Installation Guide and the
Rational Rose RealTime Release Notes for information on installing the
base product.

What’s New

These are the new features included in this release of Rational Rose
RealTime.
m Support for Additional hosts
o Windows XP
m Online Help Improvements
o A larger, more comprehensive index.

o Viewlets - animated demonstrations on a variety of How Do I...
topics.

o Improved tutorials.
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What’s New

m Workflow enhancements

o Aggregation Tool - enables you to quickly create, modify, and
manage aggregate and composite associations.

o Attribute Tool - enables you to quickly create and set options for
an attribute.

o Operation Tool - enables you to quickly create and set options
for an operation.

o Ability to add class operations directly from a Sequence
diagram.

o Ability to use the target build specification when building a
model - see rtsetup.pl.

m Debugging

o Source debugging integration with Microsoft Embedded Visual
Tools (EMVT).

o Basic model debugging with Microsoft Windows CE.
m Test Models

o Used to validate your target configuration after you make a
configuration change.

m Installation Changes

o Rational Rose RealTime for UNIX is now included on the
Rational Suite DevelopmentStudio (UNIX) CD. This new
rs_install process includes many enhancements to quickly get
you started with Rational Rose RealTime.

Rational Quality Architect - RealTime Edition (RQA-RT)

With RQA-RT, you can use sequence diagrams to test the integrity of a
system. You can also test in isolation by isolating capsules. Use RQA-
RT to facilitate unit testing and scenario testing.

Rational Connexis

Support for new ports
Support has been added for the following operating systems:
m Windows CE (sh3)

Note: Table 2, “Supported platforms and targets,” on page 14,
provides detailed information about the new Rational Connexis ports.
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Chapter 2

V‘ Overview of the Professional Packages

The Release Notes and Installation Guide for Rational Rose RealTime
Professional applies to the Rational Rose RealTime Professional
package and the Rose RealTime Professional Porting package.

The Rational Rose RealTime Professional Package

In addition to Rose RealTime, the Rose RealTime Professional package
includes the following software:

m Rational Connexis
m Rational Quality Architect- RealTime Edition
m Rational Target Deployment Package

Rational Connexis

Connexis simplifies the construction of reliable, distributed
applications using Rational Rose RealTime. You can easily establish
communication paths and send messages between capsules in
separate processes whether they reside on the same node or on
separate nodes. Also, you can monitor connections, trace messages,
and collect communication metrics.

With Rational Connexis, you can distribute applications built with
Rational Rose RealTime version 2002.05.00. Connexis also provides
features to help you build reliable distributed applications.

Release Notes and Installation Guide - Rational Rose RealTime Professional 5



Chapter 2 Overview of the Professional Packages

Connexis extends the asynchronous messaging used between capsules
in Rational Rose RealTime so that it can be used between capsules
located in different processes or different nodes in a network. Connexis
allows you to use unwired ports, based on protocols you define, to
establish these connections. Since the same mechanisms are used for
local and remote messaging, it is easy to make your application
distributed.

Using a publish and subscribe pattern, Connexis can connect capsules
whether they are on the same processor, distributed on a backplane,
across a network connection, or through some other channel. To
implement these connections, Connexis uses the underlying TCP/IP
stack of the operating system.

Connexis also includes several features to provide fault-tolerance
capabilities to the applications you build with Rose RealTime. The
Connexis Locator Service, which can be used to find connection
destinations, supports the use of a backup locator to automatically
take over should the primary locator fail.

Run-Time connectivity viewing

Determining connectivity in a distributed system can be tedious and
time-consuming. To make this easier, Connexis includes a connectivity
trace tool, the Connexis Viewer, that lets you examine and monitor
connection status in real-time. You can easily determine the services
that have been published and who has subscribed to them, wherever
the publishers and subscribers may be on your network.

The Connexis Viewer also lets you trace messages between publishers
and subscribers. You can apply filters to restrict the trace information
being captured and you can also specify the number and size of the
memory buffers allocated for tracing. This allows you to carefully
control the allocation and use of tracing resources on target.

Together, these features provide easy, convenient, and fault-tolerant
connectivity. Instead of building your own distributed communications
infrastructure, you can build additional revenue-generating features
into your product. The result is that your product ships sooner with
more features.

Please refer to the User Guide - Rational Rose RealTime Connexis for a
complete description of the Connexis product.
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The Rational Rose RealTime Professional Package

Rational Quality Architect - RealTime Edition

Rational Quality Architect automates scenario-based unit testing. You
can create sequence diagrams that specify how any set of capsules
interact. With a single command, Rational Quality Architect generates
and builds test harnesses along with any requested stubs, runs the
tests on the specified target, collects the results at run-time, compares
those results with the original sequence diagrams, and highlights any
differences between them along with any detected race conditions.

Using Rational Quality Architect - RealTime Edition (RQA-RT), you can
extend Rational Rose RealTime’s design automation capabilities to
model, debug and test. By automatically generating complete unit and
integration test harnesses directly from sequence diagram
specifications, manual coding of stubs and drivers for debugging and
testing is eliminated.

RQA-RT automatically verifies designs against sequence diagram
specifications both analytically and during execution. Application
generation and automatic testing of fully or partially complete designs,
plus animated visual and symbolic debuggers, encourages early and
continuous design refinement and validation.

For detailed information on RQA-RT, see the User’s Guide - Rational
Quality Architect RealTime Edition.
Allow sub-capsule instances to be drivers

This functionality provides a way to implement “stub” generation for
contained capsule instances. By providing this functionality RQA-RT
enables more robust testing and more complex interactions.

Verification mode changes to allow more control in manual
mode

This functionality enables RQA-RT to operate in manual mode and
provides the functionality to run the harness on a custom node.

Allow data qualifier in data field of send message

This functionality enables full composite data types to be passed as the
signal data, allowing the same range of data flexibility or inject
capability as in the toolset.
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Chapter 2 Overview of the Professional Packages

Allow drivers to model timing services

When a timing service is invoked from the driver interaction instance,
it will be generated into the driver capsule. This provides more robust
support for converting trace diagrams into specifications.

Capsule interface generation for instances on sequence
diagram without role specified

Required test wrappers are automatically generated based on the user
supplied sequence diagrams.

Java language support

Enables RQA-RT functionality on a model based on the Java Language
add-in.

Rational Rose RealTime Target Deployment Package

The Target Deployment Package includes the source code for the UML
Services Libraries. These libraries provide Rose RealTime generated
applications with a platform-independent set of services such as
communication, timing, capsule lifecycle management, and state
machine execution. The UML Services Libraries also include an
adaptation layer that maps the platform-independent services to the
specific services provided by the target platform. The Target
Deployment Package includes adaptations for many popular targets.

Rational Rose RealTime Target Deployment Package provides you with
one or more embedded targets for integration with your Rational Rose
RealTime toolset.

After you installed the Rational Rose RealTime Professional Package,
with the install key included with the Professional Package shipment,
you have support for the base Target Deployment Package embedded
targets as identified above.

8 Release Notes and Installation Guide - Rational Rose RealTime Professional



Rational Rose RealTime Target Porting Package

Rational Rose RealTime Target Porting Package

The Rose RealTime Professional Porting package includes the same
software as the Rose RealTime Professional package, except that it
includes the Target Porting Package instead of the Target Deployment
Package. The Target Porting Package, like the Target Deployment
Package, includes the source code for the UML Services Libraries.
However, the Target Porting Package does not include any adaptations
for any targets other than the host platforms on which the Rose
RealTime toolset runs.

The porting package provides you with the tools necessary to develop
or deploy for a custom embedded target environment. Included with
this package are the porting guides for both the C and C++ languages
along with example ports for each of these environments.

After you have installed the Rational Rose RealTime Professional
Package, the porting guides will be included in the online help, and
PDF versions are located in the directory % ROSERT_HOME%\Help on
Windows or SROSERT_HOME /Help on UNIX:

m cpp_portingguide.pdf
m c_portingguide.pdf

Please refer to the appropriate porting guide for information on where
the various components of the example ports can be found.

As you are planning to develop and deploy on a target line-up which is
not a formally supported platform, see the supported platforms section
of the Installation Guide, Rational Rose RealTime. Please note that
product support will be based on the closest reference platform as
identified in the supported platforms section.
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m Referenced Configurations

Referenced Configurations

Referenced Configuration Requirements for Windows NT

The minimum supported configuration for running Rose RealTime on
Windows NT is:
Windows NT 4.0, with service pack 6a

Minimum Pentium 150 MHz. We recommend 500 MHz or faster
CPU

Minimum 128 MB of RAM. We recommend 256 MB of RAM
Minimum 325 MB of disk space for the Rose RealTime installation

Minimum display 1024 X 768. We recommend 1280 X 1024 or
better

Postscript printer for printing

Browser requirement - Internet Explorer 5.01 or 5.5 or Netscape
Navigator 4.7 or 6.0. We recommend Internet Explorer 5.01 or 5.5

Referenced Configuration Requirements for Windows 2000

The minimum supported configuration for running Rose RealTime on
Windows 2000 is:
Windows 2000 Professional, with service pack 1

Minimum Pentium 150 MHz. We recommend 500 MHz or faster
CPU

m Minimum 128 MB of RAM. We recommend 256 MB of RAM

Release Notes and Installation Guide - Rational Rose RealTime Professional 11
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Minimum 325 MB of disk space for the Rose RealTime installation

Minimum display 1024 X 768. We recommend 1280 X 1024 or
better

Postscript printer for printing

Browser requirement - Internet Explorer 5.01 or 5.5 or Netscape
Navigator 4.7 or 6.0. We recommend Internet Explorer 5.01 or 5.5

Referenced Configuration Requirements for Windows XP Pro

The minimum supported configuration for running Rose RealTime on
Windows XP Pro is:

Minimum Pentium 300 MHz. We recommend 500 MHz or faster
CPU

Minimum 128 MB of RAM. We recommend 256 MB of RAM
Minimum 325 MB of disk space for the Rose RealTime installation

Minimum display 1024 X 768. We recommend 1280 X 1024 or
better

Postscript printer for printing

Browser requirement - Internet Explorer 5.01 or 5.5 or Netscape
Navigator 4.7 or 6.0. We recommend Internet Explorer 5.01 or 5.5

Referenced Configuration Requirements for UNIX

12

The minimum supported configuration for running Rose RealTime on
UNIX is:

Solaris 2.6, Solaris 2.7, Solaris 2.8, or HPUX 10.20

o For Solaris operation, the minimum workstation is an
UltraSparc 10. We recommend an UltraSparc 60 with 512 MB of
RAM. We recommend the Solaris 2.8 operating system.

o For HPUX operation, we support installation of the HP 700
series architecture

o Please see the Rational Rose RealTime web site
(http://www.rational.com/support) for a list of the required
UNIX patches applicable to your operating system.

The minimum is 256 MB of RAM. We recommend 512 MB of RAM
with approximately three times this amount of swap space.

Minimum 370 MB of disk space for the Rose RealTime installation

Release Notes and Installation Guide - Rational Rose RealTime Professional
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Referenced Host Configurations for Rational Rose RealTime

Table 1 shows the supported host platforms for this release of Rational
Rose RealTime.

Note: Rational Rose RealTime is not supported on Windows 95.

Table 1 Host Configurations

Toolset Host

Solaris 2.6

Solaris 2.7

Solaris 2.8

Windows NT 4.0 (Service Pack SP6a)
Windows 2000 (Service Packs SP1 and SP2)
Windows XP Pro

HPUX 10.20

Note: Java generation on HPUX is not supported.

A pre-defined set of the Rose RealTime UML Services Libraries are
delivered as part of the Rational Rose RealTime product. The UML
Services Library is what allows standalone executable models to be
executed on target operating systems. These ports are fully tested by
Rational, and are covered by standard Rational support. A standard
port can be used to facilitate a port to your environment of choice.

Note: For a more detailed description of the Services Library, refer to the
programmer’s guide or online documentation or see the online
documentation.

A port is based on the following specifics (often called the toolchain
line-up or configuration):

m OS version
m Compiler version
m Processor type

Release Notes and Installation Guide - Rational Rose RealTime Professional 13



Chapter 3 Referenced Configurations

If you use a configuration other than the one tested by Rational and
listed in this guide, standard support covers problems that are
reproducible on referenced configurations in this guide. Table 2 shows
the referenced configurations and targets.

Table 2 Supported platforms and targets

Host Target RTOS Compiler/Processor RTS DCS
Configuration(s)
Solaris Same Gnu 2.95.1, sparc C++ C++
Gnu 2.8.1, sparc C&C++ C++
Gnu 2.7.2.3, sparc C++ -
Sun C++ 5.0, sparc C++ C++
Sun C 5.0, sparc C -
HPUX Same Gnu 2.8.1, hppa C&C++ C++
HP C++ 10.11, hppa C++ -
Windows Same Visual C++ 6.0, x86 C&C++ C++
Solaris, Windows pSOS 2.5 Diab 4.2b, ppc C++ C++
Solaris, HPUX VRTX 4.AB Microtec 1.3C, ppc C++ n/a
Windows VRTX 4.Baa Microtec 1.4, ppc C++ -
Solaris, Windows OSE 4.1.1 Diab 4.3f, ppc C & C++ C++
GreenHills 1.8.9, ppc C -
GreenHills 2.0, ppc C -
Solaris OSE 4.1.1 Gnu 2.95.1, sparc C&C++ -
SoftKernel
Windows OSE 4.1.1 Visual C++ 6.0, x86 C -
SoftKernel
Solaris, Windows, Tornado 2.0 Cygnus 2.7.2.960126, M68040 C&C++ -
HPUX (VxWorks 5.4) Cygnus 2.7.2.960126 C&C++ C++
Cygnus 2.7.2.960126, ppc C&C++ -
GreenHills 1.8.9, x86¢ C&C++ C++
GreenHills 2.0, ppc C&C++ C++
Solaris Tornado 2.0 Sim Cygnus 2.7.2.960126, sparc C++ C++
Windows NT Tornado 2.0 Sim eges 2.90.29, x86 C++ C++
Solaris, Windows LYNX 3.1.0a gnupro-2.9-98r2, ppc C++ C++
Solaris LYNX 3.0.1 Cygnus 2.7.97r1, x86 C++ C++
Cygnus 2.7.97r1, ppc C++ C++
14 Release Notes and Installation Guide - Rational Rose RealTime Professional
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Table 2 Supported platforms and targets

Host Target RTOS Compiler/Processor RTS DCS

Configuration(s)

Solaris Chorus Classix egcs-2.91.66, ppc C++ -

4.0

Windows Windows CE sh3 eMbedded Visual C++ 3.0, sh3 C++ C++

N/C - native AIX 4.2.1 gnu 2.8.1 C++ -

compilation only

N/C - native Nucleus 1.1 Diab 4.2b C++ -

compilation only

N/C - native Red Hat Linux 6.1 Egcs 2.91.66 C++ C++

compilation only

N/C - native QNX 4.2.2 Watcom C++ 10.6 C++ -

compilation only

N/C - native UnixWare 7.0.1 SDK 3.0 C++ C++

compilation only

Host Target RTOS Compiler/Processor RTS DCS

Configuration(s)

Solaris Same Gnu 2.95.1, sparc C++ C++
Gnu 2.8.1, sparc C&C++ C++
Gnu 2.7.2.3, sparc C++ -
Sun C++ 5.0, sparc C++ C++
Sun C 5.0, sparc C -

PSOS 2.5/PPC/Diab 4.2b DCS Port

The pSOS installation provides a board-support package (BSP) with
settings that must be customized for running Connexis applications.
Depending on the hardware parameters of your board, you must

adjust the settings according to your requirements.

The following excerpt from the file sys_config.h in the BSP directory
shows a sample set of configuration parameters. Pay special attention
to the comments containing additional notes that are in brackets. For
example, the comment: max number of tasks (25 -> 35), for xc NTASK,
means that the maximum number of tasks has been increased to 35
for Connexis applications.

Release Notes and Installation Guide - Rational Rose RealTime Professional

15



Chapter 3 Referenced Configurations

The following component configuration parameters work as they are for
this application. Modify them to your requirements to customize the

application.
/***********************************************************************/
/* */
/* COMPONENT CONFIGURATION PARAMETETRS */
/* */

/* These parameters should work as is for this application. You */
/* may want to change some of them if you start customizing this */
/* application. */
/* */

/***********************************************************************/

*/

/* pSOS+ configuration parameters - change these for Connexis
applications. */

A e e
*/

#define KC RNOUSIZE 0x100 /* region 0 unit size

*/

#define KC NTASK 35 /* max number of tasks (25 -> 35)

*/

#define KC NQUEUE 15 /* max number of message queues (10 ->
15) */

#define KC NSEMA4 60 /* max number of semaphores (30 -> 60)

*/

#define KC_NTIMER 15 /* max number of timers (10 -> 15)

*/

#define KC NMUTEX 60 /* Max number of mutexes (30 -> 60)

*/

#define KC_ NCVAR 10 /* Max number of condition variables (5-
>10) */

#define KC NTVAR 10 /* Max number of task variables (5 -> 10)
*/

#define KC_NCOCB 5 /* Max number of callouts

*/

#define KC NTSD 5 /* Max # of Task Specific Data entries

*/

#define KC_NLOCOBJ 80 /* max number of local objects (50 -> 80)
*/

#define KC_ NMSGBUF 384 /* max number of message buffers (256-
>384)*/

#define KC TICKS2SEC 100 /* clock tick interrupt frequency

*/
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#define
*/
#define
*/
#define
*/
#define
A) */
#define
*/
#define
*/
#define
*/
#define
*/
#define
*/
#define
*/
#define
*/

KC TICKS2SLICE 10 /* time slice quantum, in ticks

KC MAXDNTENT 0 /* max number of device names in DNT

KC DNLEN 10 /* max length of a device name in DNT

KC SYSSTK 0xA000 /* pSOS+ system stack size (bytes) (8->
KC_ROOTSSTK 0xA000 /* ROOT supervisor stack size (8 -> A)
KC_ IDLESTK 0x0500 /* IDLE stack size (4 -> 5)
KC_ROOTUSTK 0xA000 /* ROOT user stack size (8 -> A4)
KC_ROOTMODE (T_SUPV | T ISR) /* ROOT initial mode

KC_ROOTPRI 230 /* ROOT task priority
KC_NIO (SC_DEVMAX+1) /* # of devices in initial iojtab
KC_MAXIO (SC_DEVMAX+3) /* Max # of devices in the system

Note: These settings differ depending on the target board
characteristics (such as memory)

Multi-node system support

The pSOS OS lets you configure multi-node systems. Each node has a
unique ID number. During start-up, Connexis requires the node
number on which the Connexis binary will run. For this purpose, the
following command-line parameter informs the Connexis library about
the node number:

-CNXpSOS_node = x

where x is an integer, specifying the node ID. If not specified, the
default is O (zero) for single-node system.
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Known problems

m At the time of this release, the number of user-created threads has
an impact on system performance. Increasing the number of
threads decreases system performance in a linear fashion.

m In this release of Connexis, the pSOS system does not support
dynamic resolution of network addresses for a given IP address.
Connexis end-points should be specified with explicit IP addresses.

Table 3 provides an example of a syntax that is supported and a syntax
that is not supported by the DCS for pSOS.

Table 3

Supported Not Supported

-CNXlpep=cdm://<IP address>:<port> -CNXlpep=cdm://<CPU name>:<port>

example: example:
CNXlpep=cdm://193.138.253.54:3100 -CNXlpep=cdm://sparcl11:3100

TORNADO 2.0/SimSo/Cygnus 2.7.2-960126 DCS Port

18

This section describes the board-support package (BSP) and VxWorks
kernel settings applied when testing the Tornado 2.0/SimSo/Cygnus
2.7.2-960126 port.

The Tornado installations provide a standard VxWorks simulator with
no networking capabilities. If you are using Connexis under the
VxWorks simulator, install the full VxWorks simulator.

To configure the full Solaris simulator with networking:

1. Use the Create Project facility to create a bootable VxWorks image.
On the VxWorks tab in the Project Workspace window, select the
folder called network components. Right-click and select “Include
network components” from the context menu. Uncheck BSD
interface support and check PPP and PPP boot or ULIP and ULIP
boot. Click OK.

2. Ifyou are only using PPP, go to the obsolete components folder and
include 5.2 serial drivers. Right-click the element to open the
Properties window, click the Params tab, and confirm that
NUM_TTY is set to 2.
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3. On the VxWorks tab in the Project Workspace window, select the
folder called ‘select WDB connection’ and check “WDB network
connection.” Then select the folder called 'select WDB mode' and
uncheck 'WDB system debugging.’

4. Remove the BSD attach interface and BSD interface support
components (INCLUDE_BSD_BOOT and INCLUDE_BSD) from the
network devices subfolder. If you are using PPP, also remove ULIP
and ULIP boot (INLUDE_ULIP and INCLUDE_ULIP_BOOT). See
“Known problems” on page 19 for more information.

5. Ensure that #undef INCLUDE NETWORK and #undef
INCLUDE_NET_INIT are removed from config.h or that the
“undef” parts are changed to “define.”

6. If you want to use multiple simulators simultaneously, using ULIP
on Solaris, add the following to the config.h of your BSP:

#undef WDB_COMM_TYPE

#define WDB_COMM_TYPE WDB_COMM_NETWORK

7. If you are using PPP, define the following in config.h:

#ifdef BSD43_COMPATIBLE
#undef BSD43_COMPATIBLE
#endif

8. Rebuild and download VxWorks.

Note: While downloading VxWorks, change your target server
configuration from wdbpipe to wdbrpc.

Known problems

m At the time of this release, end-points specifying the IP address (see
Table 3 ) have been specified for Connexis binaries to establish
connection, while running on top of the simulator.

m When downloading the VxWorks image, change the default value in
the Memory size(bytes) field from 3000000 to 8000000 to ensure
you have sufficient memory for your application.
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m When connecting between two Solaris machines, configure the

Solaris machines for IP forwarding.

Note: If either of the two machines does not have IP forwarding
turned on, the vxSim processes will not be able to talk to each other.

m Ensure that the routing tables are configured correctly for vxSim

processes (if connecting two vxSim processes) and the Solaris
machines (see “Example of routing tables” on page 20).

Example of routing tables

The following example illustrates how to configure routing tables.

Assume that you have the following hosts:

147.11.50.51limpopo

127.0.1.1vxsiml (running on limpopo)
147.11.50.3kaveri

127.0.1.9vxsim9 (running on kaveri)

You would then need to have the following routes:
(obtained by use of "netstat -rn"):
on limpopo:
limpopo->vxsiml 127.0.1.1 127.0.1.254 UH 3 0
limpopo->vxsim9 127.0.1.9 147.11.50.3 UGH O 3
on kaveri:
kaveri->vxsim9 127.0.1.9 127.0.1.254 UH 3 0
limpopo->vxsiml 127.0.1.1 147.11.50.5 UGH O 3
(obtained by use of "routeShow"):
on vxsiml:
vxsiml->kaveri (network route)

147.11.0.0 127.0.1.254 3 1 5

vxsiml->vxsim9 (host route)
127.0.1.9 147.11.50.3 7 0 5

ipdo

ipdo

ppPpPO

pppO



Referenced Host Configurations for Rational Rose RealTime

on vxsim9:
vxsim9->limpopo (network route)
147.11.0.0 127.0.1.254 3 1 5 ppPPO

vxsim9->vxsiml (host route)
127.0.1.1 147.11.50.5 7 0 5 pppO

Demonstrating the example

To demonstrate the routing table example, send a ping from vxsim1 to
limpopo on the localhost address, from limpopo on 147.11.50.5 to
kaveri, and from to vxsim9:

-> ping "127.0.0.1",1
127.0.0.1 is alive
value = 0 = 0x0

-> ping "147.11.50.5",1
147.11.50.5 is alive
value = 0 = 0x0

-> ping "147.11.50.3",1
147.11.50.3 is alive
value = 0 = 0x0

-> ping "127.0.1.9",1
127.0.1.9 is alive
value = 0 = 0x0

Note: Ifyou experience problems using VXsim on a host, communicating
with another host, contact WindRiver technical support.
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V‘ Installation

The Professional Edition installation key is included in the Welcome
Letter that you received with the product shipment. Contact Rational
License Support if you did not receive a Professional Edition
installation key.

Note: Rational Connexis version 2002.05.00 has been tested with
Rational Rose RealTime version 2002.05.00 only. It will not work with
earlier releases of Rational Rose RealTime.

Contents

This chapter is organized as follows:

m “Before You Install” on page 23

m ‘“Installing Rational Rose RealTime Professional Edition” on
page 24

m “After You Install” on page 30

m “Verifying the Connexis Installation” on page 31

m “Uninstalling the Professional Edition” on page 36

Before You Install

Before you install the Rational Rose RealTime Companion Products,
you must have previously installed Rational Rose RealTime
DevelopmentStudio RealTime.
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Installing Rational Rose RealTime Professional Edition

Before you install Rational Rose RealTime Professional Edition, you
must first install Rational Rose RealTime version 2002.05.00.

Windows Installations

When you install Rational Rose RealTime Professional Edition on
Windows, you have the following options:

m Client Installation (Typical) - installs Rational Rose RealTime
Professional Edition on your local system.

Note: Rational Rose RealTime must be currently installed on your
local system prior to installing the Client Installation on the Rational
Rose RealTime Companion Product CD.

m Client Installation over the Network - installs the required
components on your local system to run the Rose RealTime
Professional Edition from a network location.

Note: Rational Rose RealTime, then the Administrative Installation
of Rational Rose RealTime Professional Edition must be currently
installed on your local system prior to installing a Client Installation
over the Network installation.

m Administrative Installation - installs the files required to run
Rational Rose RealTime Professional Edition from a location on the
network.

Note: Rational Rose RealTime must be installed before installing the
Administrative Installation of Rational Rose RealTime Professional
Edition. You must complete an Administrative Installation of Rational
Rose RealTime Professional Edition before you perform a Client
Installation over the Network.

Client Installation

A typical installation installs Rational Rose RealTime Professional
Edition on your local system. Rational Rose RealTime must be installed
previously before you perform a Client Installation.
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Installing Rational Rose RealTime Professional Edition

To install the Rational Rose RealTime Professional Edition:

1. Launch Rational Rose RealTime, click Help > About, then verify
that Rational Rose RealTime version 2002.05.00 is currently
installed.

2. Insert the Rational Rose RealTime Companion Products CD into your
CD-ROM drive.

If the system is configured with the autorun feature enabled, the
setup program will run automatically and you may continue with
step 4.

3. Use Windows Explorer to open a window displaying the contents of
the CD-ROM. For example, double-click My Computer and
double-click the icon for the Rational Rose RealTime Companion Products CD.
Double-click the Setup.exe icon to run Setup.

Note: The .exe file name extension may not be visible.

The Setup dialog box appears followed by the Welcome dialog box.
4. Click Next to view the License Agreement.
You must accept the license agreement to proceed.

If you do not agree with the terms of the license agreement, you
should exit the installation. All software and documentation should
be returned to Rational Software.

If you accept the terms and conditions of the license agreement,
click Yes.

The Setup Type dialog appears.
5. Select Typical.
When prompted, type the installation key.
7. Click Next.

o

Note: The Professional Edition installation key is included in the
Welcome Letter you received with the product shipment. Contact
Rational License Support if you did not receive a Rational Rose
RealTime Professional Edition installation key.

8. Select a Program Folder, then click Next.
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9. In the Information Summary dialog, review the information and

click Next.
The products selected for installation are listed.

10. Click Next to start the installation.
11. Click OK when prompted to copy both DLLs.
12. Click Finish.

Administrative Installation

To successfully complete the Administrative Installation of Rational
Rose RealTime Professional Edition, you must first install an
Administrative Installation of Rational Suite DevelopmentStudio
RealTime on the network. For information on installing Rational Suite
DevelopmentStudio, see the book Installing Rational Suite
DevelopmentStudio.

During an Administrative Installation of Rational Rose RealTime
Professional Edition, the required components necessary to run
Rational Rose RealTime Professional Edition over a network are copied
to the Administrative Installation Target directory. The Administrative
Installation Target directory is created by the administrative
installation of Rational Suite DevelopmentStudio RealTime and is
available on the network.

To install the Rational Rose RealTime Professional Edition:

1. Launch Rational Rose RealTime, click Help > About, then verify
that Rational Rose RealTime version 2002.05.00 is currently
installed.

2. Insert the Rational Rose RealTime Companion Products CD into your

CD-ROM drive.

If the system is configured with the autorun feature enabled, the
setup program will run automatically and you may continue with
step 4.

3. Use Windows Explorer to open a window displaying the contents of

the CD-ROM. For example, double-click My Computer and
double-click the icon for the Rational Rose RealTime Companion Products CD.
Double-click the Setup.exe icon to run Setup.

Note: The .exe file name extension may not be visible.

The Setup dialog box appears followed by the Welcome dialog box.
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N

10.

11.

12.
13.

Click Next to view the License Agreement.
You must accept the license agreement to proceed.

If you do not agree with the terms of the license agreement, you
should exit the installation. All software and documentation should
be returned to Rational Software.

If you accept the terms and conditions of the license agreement,
click Yes.

The Setup Type dialog appears.

Select Administrative from the Setup Type dialog list.

Note: An Administrative Installation of Rational DevelopmentStudio
RealTime Edition must be completed, before installing the Rose
RealTime Professional Edition for administrative use.

Click Next.

Enter your installation key.

Click Next.

Note: The Rational Rose RealTime Professional Edition installation
key is provided in the Welcome Letter that you received with the
product shipment. Contact Rational License Support if you did not
receive a Professional Edition installation key.

The products selected for installation are listed. Click Next.

In the Information Summary dialog, review the information and
click Next.

The Choose Destination Location dialog appears.

Browse to the Administrative Install Target directory. This is the
destination path provided during the administrative installation of
Rational DevelopmentStudio RealTime Edition.

Click Next to start the installation.
Click Finish.

Client Installation over the Network

A client installation over the network configures the client computer to
run Rational Rose RealTime Professional Edition from a location on the
network. Before you can perform a client installation over the network,
you must have Rational Rose RealTime version 2002.05.00 installed,
then have installed an Administration Installation of Rational Rose
RealTime Professional Edition.
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To install the Rational Rose RealTime Professional Edition:

1.

o

Launch Rational Rose RealTime, click Help > About, then verify
that Rational Rose RealTime version 2002.05.00 is currently
installed.

Insert the Rational Rose RealTime Companion Products CD into your
CD-ROM drive.

If the system is configured with the autorun feature enabled, the
setup program will run automatically and you may continue with
step 4.

Use Windows Explorer to open a window displaying the contents of
the

CD-ROM. For example, double-click My Computer and double-
click the icon for the Rational Rose RealTime Companion Products CD. Double-
click the Setup.exe icon to run Setup.

Note: The .exe file name extension may not be visible.

The Setup dialog box appears followed by the Welcome dialog box.
Click Next to view the License Agreement.
You must accept the license agreement to proceed.

If you do not agree with the terms of the license agreement, you
should exit the installation. All software and documentation should
be returned to Rational Software.

If you accept the terms and conditions of the license agreement,
click Yes.

The Setup Type dialog appears.

Select Network.

When prompted, type the installation key.

Click Next.

Note: The Professional Edition installation key is included in the
Welcome Letter you received with the product shipment. Contact

Rational License Support if you did not receive a Rational Rose
RealTime Professional Edition installation key.

Select a Program Folder, then click Next.
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10.
11.

In the Information Summary dialog, review the information and
click Next.

The products selected for installation are listed.
Click Next to start the installation.
Click Finish.

UNIX installation

Before you install Rational Rose RealTime Professional Edition, you
must first install Rational Suite DevelopmentStudio RealTime (UNIX).
For information on installing Rational Rose RealTime, see the Rational
Rose RealTime Installation Guide.

To install the Rational Rose RealTime Professional Edition, follow these
steps:

1.

2.

4.

Insert the Rational Rose RealTime Companion Products CD into your CD-ROM
drive.

Mount the CD-ROM device.

Typically, to mount a CD-ROM device, you are a system
administrator (root or super-user). See the instructions for your
particular CD-ROM drive and operating system for details.

HP-UX:

mount -rt cdfs /dev/dsk/c201d511 /cdrom

Solaris

mount -rF hsfs /dev/srl/cdrom

where

/dev/srl is the CD-ROM device

Note: In Solaris, the CD-ROM may be automatically mounted.
From a shell window, change the directory to the mounted
CD-ROM device.

For example,

cd /cdrom

Run the setup script.

./setup.sh
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5.

10.

11.

Enter the installation key and press ENTER.

Note: The Rational Rose RealTime Professional Edition installation
key is provided in the Welcome Letter that you have received with the
product shipment. Contact Rational License Support if you did not
receive a Professional Edition installation key.

Review the terms of the license agreement and do one of the
following:

m To accept the agreement, type Y and press ENTER.

m To read the agreement again, type R and press ENTER.
m To quit, type Q and press ENTER.

You must accept the license agreement to proceed.

If you do not agree with the terms of the license agreement, you
should quit the installation. All software and documentation
should be returned to Rational Software.

Select a platform.

You can specify HP10 only, Sunb only, or both HP10 and Sun5.
Regardless of which configuration you specify, the corresponding
files are installed to a separate directory.

Note: Install the correct configuration (an HP or Sun installed
RoseRT) from the Rational Suite DevelopmentStudio - RealTime
(UNIX).

To modify the platform settings, type M or to accept the platform
settings, type Y.
Press ENTER.

Specify an absolute installation path in which the Rational Rose
RealTime product is installed.

After the installation completes, dismount the CD and store it in a
safe place with the Welcome Letter.

After You Install

30

After you install the Rational Rose RealTime Companion Products, you
must set the environment variable for CONNEXIS_HOME to the
appropriate location, such as:

setenv CONNEXIS HOME S$ROSERT HOME/Connexis
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Note: Set this environment variable after SROSERT HOME is created
(either by setenv ROSERT HOME or in a rs_install setup after you
source <rational dirs>/rosert setup.xxx, where xxxis .cshor
.sh.)

Verifying the Connexis Installation

To increase efficiency and eliminate improper installation and/or
setup misconfiguration, you are strongly encouraged to verify your
installation after you have installed the Professional Edition package
on your machine. As a minimum, you should verify your Connexis
installation by using the BasicTest model provided with Connexis in
$SCONNEXIS HOME/Connexis. This model uses the CDM transport.

Verifying your installation using BasicTest

You can easily verify your installation by using the BasicTest model
provided with Connexis in:

SROSERT HOME/Connexis/C++/examples

Host configuration installation verification

The following instructions are for Windows NT, Windows 2000, and
Windows XP Pro setup with Microsoft Visual C++ 6.0. If you use Visual
C++ 6.0, please use the elements corresponding to VC++6.0.

The following instructions are for the host platforms (Windows, Solaris,
HP-UX). The package names, component names, and component
instance names differ for each platform. Table 4 and Table 5 define the
names that are applicable for each of the supported host platforms.

Please use the information provided in Table 4 and Table 5, when
completing the following steps:
1. Start Rose RealTime.

2. Load the BasicTest model from
SROSERT_HOME/Connexis/C++/examples.

3. From the Component View, expand the component package
corresponding to your host platform.

4. Select the client component and from its item menu, choose
Build > Rebuild All to recompile it.
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10.

Select the server component and from its item menu, choose
Build > Rebuild All to recompile it

From the Deployment View’s NT40 package, expand the processor
that corresponds to you host platform.

The client will listen at port 9100 and the server will listen at port
9900. If these ports are being used by other another application on
your workstation, you will need to change them. Open the server
component instance's specification sheet and change the "9900" in
the -CNXep startup parameter to an available port number. Open
the client component instance's specification sheet and change the
"9900" specified in the "-s" argument to the server's port number.
Change the "9100" in the "-CNXep" startup parameter to an
available port number. Save your changes.

Select the server component instance and choose Run from its item
menu. On the RTS panel of the instance, click the Start button to
execute the server.

On the Model panel, select the client component instance and
choose Run from its item menu. On the RTS panel of the instance,
click the Start button to execute the client.

Verify that your output for client and server looks similar to the
output shown in sections “BasicTest Server output” and
“BasicTest.”

Table 4 Components for referenced configurations

Component Package Client Component Server Component
WindowsMS NT40-x86-VCC60 basicTestClient_31 basicTestServer_31
Visual Studio 6.0
SolarisGnu 2.81 SUN5-sparc-gnu-281 basicTestClient_5 basicTestServer_5

SolarisSun
Workshop 5.0

HP-UXGnu 2.81

SUN5-sparc-SunCC-50  basicTestClient_4 basicTestServer_4

HPUX10-hppa-gnu-281 basicTestClient 35  basicTestServer_35

32
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Table 5 Component Instances for referenced configurations

Component Client Client Server
Package Component Component Component
Instance Instance

WindowsMS NT40 MyNT40Workstati basicTestClient 3 basicTestServer_3
Visual Studio on lInstance lInstance
6.0
SolarisGnu Solaris MySparcstation basicTestClient_ 5 basicTestServer_5
2.81 Instance Instance
SolarisSun Solaris MySparcstation basicTestClient_4 basicTestServer_4
Workshop 5.0 Instance Instance
HP-UXGnu Hpux MyHPWorkstation basicTestClient 3 basicTestServer_3
2.81 5Instance 5Instance
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BasicTest server output

Rational Rose RealTime C++ Target Run Time System
Release 6.40.B.00 (+c)

Copyright (c¢) 1993-2001 Rational Software

rosert: observability listening at tcp port 30399

khkhkhkhkhkhkhkhkhkhkhkhkhkhhkhhkhkhhkhhkhkhhkhhhhkhhkhkhkhkhhkhkhhkhkhkhkhkhkhhkhkhkhkhkhkhkhkhkhkhkkhkhkhkhkkkkkk
* Please note: STDIN is turned off. *
* To use the command line, telnet to the above mentioned port. *

* The output of any command will be displayed in _this window. *
khkhkhhkkhkhhhkhkhhhkhhhhkhhhhhkhhhhkhhkhhhhhkhhhhkhhhhkhhhhkhhhhhkhhhhkhhhhkhkhhhkkhk

Rational Software Corp. Connexis(tm) - Distributed Connection Service
(des)

Release 6.40.B.82

Copyright (c) 1999-2001 Rational Software Corporation

dcs: CRM Transport : enabled

dcs: CDM Transport : enabled

dcs: CRM listening at [crm://192.139.251.167:2005]

dcs: CDM listening at [cdm://192.139.251.167:9900]

dcs: target agent enabled

dcs: locator service not available

dcs: metric service enabled

BasicTest-Server-started:

Server : Received simple greeting message... sending it back
Server : test cycle completed, received rtunbound !

Server : Received simple greeting message... sending it back
Server : test cycle completed, received rtunbound !

Note: The above represents a partial listing of the BasicTest Server
Output.
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BasicTest client output

Rational Rose RealTime C++ Target Run Time System
Release 6.40.B.00 (+c)

Copyright (c) 1993-2001 Rational Software

rosert: observability listening at tcp port 30380

khkhkhhkhkhkhhhkhkhhhkhkhhhhhhhhkhhhhkhhkhhhhhkhhhhkhhhhkhhhhkhhhhhkhhhhkhkhhhkhkhhhkkkk

* Please note: STDIN is turned off. *
* To use the command line, telnet to the above mentioned port. *

* The output of any command will be displayed in _this window. *
khkhkhkhkhkhkhhhkhkhhhkhkhhhkhhhhhkhhhhkhhkhhhhhhhhhkhhhhkhhhhkhhhhhkhhhhkhhhhkhkhhkkhkkk

Rational Software Corp. Connexis(tm) - Distributed Connection Service
(des)

Release 6.40.B.82

Copyright (c) 1999-2001 Rational Software Corporation

BasicTest-Client-started:

dcs: CRM Transport : enabled

dcs: CDM Transport : enabled

dcs: CRM listening at [crm://192.139.251.167:2010]
dcs: CDM listening at [cdm://192.139.251.167:9100]
dcs: target agent enabled

dcs: locator service not available

dcs: metric service enabled

Client : sending a greeting message...

->Client: received message:
RTString"Hello, Welcome to the Connexis world!"

Client : unbound received
Client : reregistering SAP
Client : sending a greeting message...

->Client: received message:
RTString"Hello, Welcome to the Connexis world!"

Client : unbound received

Note: The above represents a partial listing of the BasicTest Client
Output.
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Uninstalling the Professional Edition

Uninstalling in Windows

To uninstall the Rational Rose RealTime Professional Package:

1.
2.

Copy any model changes that you made to the example models.
Copy any files added to, or modified in the

SROSERT _HOME/C++/TargetRTS directories to a temporary
directory to preserve these changes. Later, you will migrate these
changes to the new installation location.

From the Start menu, select Start > Programs > Rational Rose RealTime
Companion Products > Uninstall Companion Products for Rational Rose RealTime.

Note: Uninstalling Rose for RealTime will not uninstall Rational Rose
RealTime Professional products.

Uninstalling in Solaris or HP-UX

To uninstall the Rational Rose RealTime Professional Package:

36

1.

2.

Save any user models or user data files in another location before
removing the installation directory.

Remove the installation directory and all of its contents.

Remove the following files from the $ROSERT HOME/bin/registry
directory:

m Connexis.reg
m Connexis.svr
m rqart.svr

Recreate the Rose RealTime registry to completely remove the
Connexis add-in by entering the following:

RoseRT -recreate registry

Release Notes and Installation Guide - Rational Rose RealTime Professional



Chapter 5

V‘ Converting Models from Connexis

This section describes how to convert a model from Rational Connexis
version 2000.02.10 to Rational Connexis, version 2002.05.00.

Converting Connexis version 2000.02.10 Models to Connexis
Version 2002.05.00 Models

If you are using version 2000.02.10 of Connexis, the Connexis Model
Conversion Tool searches your model, identifying any
incompatibilities, and provides a detailed description, explaining the
changes. Table 6, explains the changes that are made to your model
during the conversion process.

Table 6 Model Conversion for Connexis version 2000.02.10 to Connexis
version 2002.05.00

Condition

Change

RTDXBase, RTDXBase_Agent,
RTDXBase_Locator,
RTDXBase_Agent_Locator fixed
capsule roles are in the model

Replaces the capsule roles with the corresponding
RTDBase configuration.

Integrates the CDM transport with the capsules
containing the new RTDBase or RTDBase_Locator
capsule roles.

Integrates the CRM transport into the containing
capsule.

RTDBase, RTDBase_Locator fixed
capsule roles are in the model but
do not have the CDM transport as
an attribute.

Integrates the CDM transport using a composite
aggregation relationship into the capsules containing
RTDBase or RTDBase_Locator capsule roles.
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Table 6 Model Conversion for Connexis version 2000.02.10 to Connexis
version 2002.05.00

Condition

Change

RTDXBase optional capsule role is
in the model

Converts to the RTDBase and integrates the CRM and
CDM transports.

RTDXBase_Agent optional capsule
role is in the model

Converts to RTDBase_Agent and integrates the CRM
transport.

RTDXBase_Locator optional
capsule role is in the model

Converts to RTDBase_Locator and integrates the CDM
and CRM transports

RTDXBase_Locator_Agent
optional capsule role is in the
model

Converts to RTDBase_Locator_Agent and integrates the
CRM transport.

RTDBase or RTDBase_Locator
optional capsule role is in the
model

Users are notified that the CDM transport is integrated.

RTDBase_Agent or
RTDBase_Locator_Agent optional
capsule role is in the model

Searches the model identifying any of the components
that have a dependency on the ORB. If the dependency
exists, the CRM transport is integrated.

A component depends on a XDCS
library component

Changes the component dependency to use the DCS
library component.

The TargetConfiguration property

Removes the -CNX- or -CNX-M from the

of a component references a -CNX- TargetConfiguration name.

M or a -CNX- target configuration

To convert your model:

1. Load a model that uses version 2000.02.10 of Connexis in Rose

RealTime.

2. Select Tools > Connexis > Convert Model.
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Convert Model
Ihcompatible Capzules: |hcompatible Components:

Fing_1

Paong Pong_1
Ping_2
F'u:nni 2
Pang_&
Ping_4
Pang_4

tore Informatior... tdare Infarmation. .
Auto-Corvert Al | Cancel |

Figure 1 Convert Model dialog

3. View more information about incompatible capsules and
components by selecting the capsule or the component from the
dialog and clicking More Information.

Element Information

todel Path:

|Lngica|'\-"iew: FingPongClient; Ping

Dezcription of Incompatibility:

The capzule iz uzing a deprecated R TOHE aze capsule role.
The capsule iz uzing the ORB transport.

Suggested Course of Action:

Replace with the coresponding R TDBaze capaule role.
Inteqrate either the CRM or ORE transport into the containing capsule by
creating a "compozite aggregation' agzociation.

N DN o

Figure 2 Element Information dialog
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The “Element Information” dialog provides the following
information:
Table 7 Element Information dialog chart

Information Heading Description

Model Path Shows the path of the selected capsule or
component.

Description of Explains the reason for the incompatibility

Incompatibility between version 2000.02.10 and version
2002.05.00.

Suggested Course of Action Explains how the Conversion tool will make the
capsule or component compatible with
Connexis version 2002.05.00.

4. Click OK once you have read the information, and repeat step
three for additional capsules and components that appear in the
“Convert Model” dialog.

5. Click Auto-Convert All from the “Convert Model” dialog.

The Conversion Tool converts the incompatible capsules and
components in your model. As the conversion takes place, the
Conversion Tool may prompt you to confirm some conversion
changes.

Note: Only run the Conversion Tool once. If you run the tool a second
time, the information displayed in the Convert Model dialog may not
be accurate.

Verifying Component Compatibility with Connexis Version
The Component Verification Tool verifies that a component is

compatible with Rational Connexis version 2002.05.00.

To verify that a component is compatible with version
2002.05.00:

1. Right-click a component.
2. Select Connexis > Verify.
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Support

The Component Verification Results dialog appears.

Component Yerification Results E

Components:

todel Path:
Il:omponent Wiew: NT40-x86-CCH0

|ncompatibilities:

The component does not have a dependency on ﬂ
the 'Des' library component,

The component's target configuration is nat

supported by Connesis.

Figure 3 Component Verification dialog

3. Select the component from the Components area.

The model path and the incompatibilities for the selected
component appear.

4. Open the component from the browser and fix the
incompatibilities.
Note: You do not have to close the Component Verification Results
dialog while fixing the incompatibilities.

5. Click OK.

Support

If you encounter any problems with migrating your model to Connexis
version 2002.05.00, refer to “Technical Support” on page 53.
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m Troubleshooting and Known Issues

The following is a list of the problems and limitations in the Rational
Rose RealTime Professional Package products at the time of release.
Some of these problems may have been addressed by the time you read
this. For the most recent list of known problems and any fixes that may
have been published, please visit the Rational Rose RealTime web site
at:

http://www.rational.com/support/

Select Upgrades and Patches, then select Rational Rose RealTime.

Target Porting Package

There were no known issues at the time of release. Please visit the
Rational Web Site for the latest Release Notes, patches and
information:

Target Deployment Package

There were no known issues at the time of release. Please visit the
Rational Web Site for the latest Release Notes, patches and
information.
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Rational Connexis

The following information explains the trouble shooting and known
issues for Rational Connexis version 2002.05.00.

Troubleshooting

44

Transport Integration Framework

When implementing your Transport Integration using the Transport
Integration Framework (TIF), you must create a component to build the
Transport Integration. The Transport Integration component requires
an additional inclusion path for the TargetRTS.

Add an inclusion for:

S(ROSERT_HOME)/C++/TargetRTS/src/target/<your target>, where
<your target> maps to the target you are building.

Example:
If building for "NT40," the inclusion path would be:
S(ROSERT_HOME)/C++/TargetRTS/src/target/NT40

Turning off auditing for a single transport is not
recommended

You may not be able to turn off auditing for a single transport. This is
because setting -CNXtap=0 will result in no auditing taking place for
the CRM and CDM transports. The internal timer used by the
transporter will be set to 1 second. This may affect the -CNXtrre and -
CNXtbrd parameters which are rounded up to a multiple of -CNXtap.
Any transports integrated with an audit type other than “No Audit,” will
find the -CNXtcapi and -CNXtcapo periods to be a multiple of 1 second.
Setting -CNXtap to be > 1 second will affect the frequency at which
metrics can be collected by the viewer and other DCS enabled
applications.
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Signals no longer supported

The RTDDCSRunning and the RTDDCSrunningReply signals are no
longer supported in this version of Connexis. The recommended
fashion for determining if DCS is running, is to wait for the rtBound
signal, indicating that a successful connection to the RTDInitStatus
publisher has been made.

Rational Quality Architect - RealTime Edition

The following information explains the troubleshooting and known
issues for Rational Quality Architect - RealTime Edition version
2002.05.00.

Lost Information in "To Port" for a Message

If you load an LF-file into Rational Rose RealTime and perform the
conversion, there are a number of instances where the

information on the To Port of a message is lost. In Rational Rose
RealTime 2002.05.00, the conversion was enhanced to determine the
receiver port on any message sent between two instances that have a
direct logical connection from the sender port. This calculation
increases the time required to perform the conversion. Diagrams which
have messages between instances that skip relay ports will continue to
require the receiver port to be entered manually.

ReliableService.ebx Crashes When Running -runScriptAndQuit

When attempting to run the example RQA-RT model, called
ReliableService.rtmdl, from the Command Prompt with the RRTEI
script called ReliableService.ebs, and using the startup option -
runScriptAndQuit, the model execution will abort. The example model
runs well if you run the script from within Rose RealTime.

Do not use the VerifyBehavior command from RRTEI with the -
runScriptAndQuit option because the verification process may not
complete in this mode.

Release Notes and Installation Guide - Rational Rose RealTime Professional 45



Chapter 6 Troubleshooting and Known Issues

For example, if you use the -runScriptAnd@uit option, Rose RealTime
runs the script specified at the Command Prompt. Immediately after
the script finishes, it sends a WM_CLOSE message to itself, which is
equivalent to selecting File > Close. However, the RRTEI command
RunVerifyBehavior works asynchronously from the toolset; it returns
control to Rose RealTime before verification completes. We recommend
that you make this command the last command in the script.

Asynchronous mode is required for RQA-RT to function properly.
Solution:

Do not use the option -runScriptAndQuit with RQA-RT. You can
continue to specify the name of the ReliableService.ebs script at
the Command Prompt.

Creation of Container Capsules

RQA-RT does not automatically create container capsules for a nested
capsule when the container is not included in the Sequence Diagram.

Converting MSCs in Rational Rose RealTime using the RQA-RT
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Problem

Many MSCs have a variable of the same name (prepareSetupReqD), but
they can have a different type. When RQA-RT synthesizes these
attributes from the multiple driver instances and attempts to generate
one test driver, there is a name conflict and it selects the last Sequence
Diagram attribute's type as the type for the attribute of the test driver
class.

Background

In ObjecTime Developer, attributes are a characteristic of MSCs; each
MSC can have its own attributes. These attributes can be considered
variables for the environment which acts as a driver in TestScope.

When the MSCs are converted in Rational Rose RealTime using the
RQA-RT conversion tool, each MSC is converted to a Sequence
Diagram. In this Sequence Diagram, what was the environment in
ObjecTime Developer is now a driver capsule that is automatically
created. The interaction instance (of the driver) in the sequence
diagram has attributes which were converted from the MSC in
ObjecTime Developer.

Release Notes and Installation Guide - Rational Rose RealTime Professional



Rational Quality Architect - RealTime Edition

This newly created interaction instance is set as a driver during the
Verify Behavior operation. As a result, a new RQADriver is created.

For Example:
Seql:: driver has an attribute xAttrib of type Xtype
Seq2:: driver has an attribute xAttrib of type Ytype

Test harness generates a driver class with an attribute xAttrib of type
Xtype or Ytype. The compilation occurs and the result will be many
errors in the test harness. The errors occur because some of the action
code interprets xAttrib as type Xtype and some as type Ytype.

Workaround

Run the Sequence Diagrams from separate test harnesses. This means
that you will have completely separate components and will have to
compile again.

Creating Messages and Sequence Diagrams

The Item Properties in the Create Message Specification dialog, with
the exception of Thread, only apply if you are creating a Capsule Under
Test (CUT). Thread applies in every case. The Item Properties entries
are as follows:

m Capsule class - a capsule name. Enter a value here only if you
want to override the default capsule class associated with the role
that is associated with the interaction instance being created.

m Initial data - Enter a value here only if your Capsule Under Test
(CUT) requires data on startup. To provide data you must specify
an attribute in the driver sending the create message with the
appropriate initial values. You cannot provide initial data in create
messages sent from the environment.

m Data Descriptor - if you provided initial data, you must specify the
type descriptor of the type of data that you specified. This is in the
format RTType_<type of initial data>

m Thread name

Release Notes and Installation Guide - Rational Rose RealTime Professional 47



Sending Message Specification Data Field Format for Java

For the data to be passed with the messages, the data type should be
specified as <data_type> <constructor_arguments>. For example, to
pass Integer object referring to the number 5, place the following line:

Integer 5 or java.lang.Integer 5
If <data_type> is omitted, Integer is assumed.

The <constructor_arguments> should contain the exact line to be
passed as an argument to constructor. For example, for the
MyObject(Integer, String) the following line can be used: MyObject 5,
"Acme"

Note: No additional brackets or quotes need to be placed around
<constructor_arguments>.

Limitations

m States in a specification sequence diagram are not referenced to
states in a model (they are independent).

RQA-RT is not supported for C models.

Only leaf node instances in the interaction/sequence diagram can
be specified as a driver/stub.

m Within a sequence diagram, each interaction instance without a
specified role must have a unique name. Only one interaction
instance per test set can be left unnamed.

m Within a sequence diagram, if you run multiple tests in a single
pass, a port from a CUT can be used by only one interaction
instance with an unspecified role.

m As it is impossible to specify cardinality index for the interaction
instances with no roles specified, care should be taken then using
such objects with capsules under test and/or ports with
cardinality greater than 1.

m If the generated trace sequence diagram is directly compared with
the specification diagram, it is important to remember that such
comparison is asymmetric - sequence diagram should be used in
place of sequence diagram; trace diagram should be used in place
of trace diagram.



Rational Quality Architect - RealTime Edition

m When running multiple specifications in a test in sequence, ensure
that you complete each sequence when using a CUT, so that the
CUT is self-contained. This prevents a CUT from replying to a
message from a CUT in the previous sequence diagram.

m In a controlled model when you generate a new harness with
affected model elements not checked out, many warnings will be
generated.

m In RQA-RT Java, there may be some problems when specifying
deeply nested replicated subcapsules as drivers/stubs. The RQA-
RT test harness will not be able to distinguish particular driver
instances if driver cardinality is greater than 1. This might lead to
unexpected behavior as settings of the first driver instance (like
minimum run time) will be used for all driver instances. This
limitation does not applies to the drivers present on the top level of
driver selection dialog and drivers with cardinality equal to 1.

m Interaction instances with unspecified roles cannot be used to
simulate interaction with sub-capsules. An error will occur if an
unsupported use of "unnamed" interaction instance is detected.

Workaround: For example: top capsule A has capsule role B in it's
structure. Capsule B has capsule role C in it's structure. If you run
a test on the Sequence Diagram located under A's Structure
Diagram, "'unnamed" interaction instances can communicate with
the B, but not C. To use "unnamed" interaction instance with the
C, a Sequence Diagram should be located under B's Structure
Diagram.

Note: "'unnamed" interaction instances are not a mandatory part of
the verification process.

m If a capsule role has a cardinality greater than 1, the cardinality
index should be specified on interaction instances.

m RQA-RT support of unspecified interaction instances allows you to
easily drive an unconnected port without having to add a driver
capsule to the collaboration. More complex tests will require the
use of a driver capsule. Regardless, you cannot drive a test using a
port that is part of the system currently being tested.
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Documentation Updates

For the most recent documentation updates please visit the Rational
Rose RealTime web site at:

www.rational.com/support

Select Documentation.
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Chapter 8

V‘ Technical Support

This section describes how to submit problem reports, feature requests
and support requests to Rational Customer Service.

Submitting Problem Reports

With Rational Rose RealTime, you can email problem reports to the
Rational Software Technical Support department that services your
location. When you email a problem report directly from the Rose
RealTime application, a wizard guides you through the process,
ensuring that you provide the correct information to the Rational
Customer Service team. This information includes contact and location
information, and a detailed description of the problem that you are
reporting.

To submit a problem report:

1.

From the Help menu, click Email Technical Support.
A submenu appears, providing you with three options.
Click Problem Report.

The General Information dialog appears.

Type your contact and location information in the text areas
provided and click Next.

The Problem Report - Additional Information dialog appears.

In the Defect Title text area, type a detailed name for the problem
that your are reporting.

Select the type of problem that you are reporting from the
appropriate list boxes.
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6. Describe the problem, using the categories provided in the Details
area.

7. Click Next.
The Email Summary dialog appears.

8. Ensure that the information that appears in the Email Summary
dialog is accurate.

Note: The email information displayed in the Technical Support
Email Address is chosen based on the location information that you
provided in the General Information dialog. It is not recommended
that you edit the e-mail address.

9. If you want to save or print a copy of the email, click the
appropriate button.

10. Click Send Email to send your email.

Submitting Feature Requests

54

With Rational Rose RealTime, you can email feature requests to the
Rational Software Customer Service department that services your
location. When you email a feature request directly from the Rose
RealTime application, a wizard guides your through the process,
ensuring that you provide the correct information to the Rational
Software Customer Service department. This information includes
contact and location information, and a detailed description of the
feature that your are requesting.

To submit a feature request:

1. From the Help menu, click Email Technical Support.
A submenu appears, providing you with three options.
2. Click Feature Request.
The General Information dialog appears.

3. Type your contact and location information in the text areas
provided and click Next.

The Feature Request - Additional Information dialog appears.

4. In the Request Title text area, type a detailed name for the
Feature that you are requesting.

5. Select the level of urgency for the feature that you are requesting.
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9.

10.

Describe the feature, using the categories provided in the Details
area.

Click Next.

The Email Summary dialog appears.

Ensure that the information that appears in the Email Summary
dialog is accurate.

Note: The email information displayed in the Technical Support
Email Address is chosen based on the location information that you
provided in the General Information dialog. It is not recommended
that you edit the e-mail address.

If you want to save or print a copy of the email, click the
appropriate button.

Click Send Email to send your email.

Submitting Support Requests

With Rational Rose RealTime, you can email Support requests to the
Rational Software Customer Service department that services your
location. When you email a Support request directly from the Rose
RealTime application, a wizard guides you through the process,
ensuring that you provide the correct information to Rational Software
Customer Service department. This information includes contact and
location information, and a detailed description of the support request
that you are submitting.

To submit a support request:

1.

From the Help menu, click Email Technical Support.
A submenu appears, providing you with three options.
Click Support Request.

The General Information dialog appears.

Type your contact and location information in the text areas
provided and click Next.

The Support Request - Additional Information dialog appears.

In the Request Title text area, type a detailed name for the request
that you require.

Select the level of urgency for the question with which you need
help.
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9.

10.

Type your question in the Question text area.

Click Next.

The Email Summary dialog appears.

Ensure that the information that appears in the Email Summary
dialog is accurate.

Note: The email information displayed in the Technical Support
Email Address is chosen based on the location information that you
provided in the General Information dialog. It is not recommended
that you edit the e-mail address.

If you want to save or print a copy of the email, click the
appropriate button.

Click Send Email to send your email.

Contacting Rational Customer Service by Email or Telephone
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When contacting Rational Customer Service by email or by telephone,
please be prepared to supply the following information:

Name, telephone number, and company name
Product name and version number

Operating system and version number (for example, Windows NT
4.0, Windows 2000, Windows XP Pro, Solaris 2.6/2.7/2.8, or HP-
UX 10.20)

Computer make and model
Your case id (if you're calling about a previously reported problem)

A summary description of the problem, related errors, and how it
was made to occur

If your organization has a designated, on-site support person, please
try to contact that person before contacting Rational Customer Service.

You can obtain technical assistance by sending electronic mail to the
appropriate e-mail address. Electronic mail is acknowledged
immediately and is usually answered within one working day of its
arrival at Rational. When sending an email place “Rational Rose
RealTime” in the subject line, and in the body of your message include
a description of your problem.
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When sending email concerning a previously-reported problem, please
include in the subject field: “CaselD: vOXXXXX”, where XXXXX is the
caseid number of the issue. For example:

CaseID: v0176528 New data on rational rose realtime install issue

Sometimes Rational Customer Service engineers will ask you to fax
information to help them diagnose problems. You can also report a
technical problem by fax if you prefer. Please mark faxes “Attention:
Customer Service” and add your fax number to the information
requested above.

Telephone and fax numbers for Rational Customer Service are
contained in the following table. If you have problems or questions
regarding licensing, please see “License Support Contact Information”

on page 58.

Table 8 Support Telephone and Fax
Region Telephone Number Fax Number
Americas 800-433-5444 408-863-4300
Asia Pacific (includes +61-2-9419-0111 +61-2-9419 0123

support for Japan, China,
India, Korea, Taiwan)

Europe, Middle East, and | +31 (0)20-4546-200 +31 (0)20 4546-202
Africa (includes support
for Israel)

Other worldwide locations | 408-863-5000

Email addresses for Rational Technical Support are listed in the
following table.

Table 9 Support Email

Region Email Address

Americas and other worldwide support@rational.com
locations

Asia Pacific (includes support for support@apac.rational.com

Japan, China, India, Korea, Taiwan)

Europe, Middle East, Africa (includes | support@europe.rational.com
support for Israel), and Scandinavia
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License Support Contact Information
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If you have a problem or questions regarding the licensing of your
Rational Software products, please contact the Licensing Support

office nearest you.

Telephone numbers for license support are listed in the following table.
Ask for, or select, Licensing Support.

Table 10 License Support Telephone and Fax

Region

Telephone Number

Fax Number

Americas

800-433-5444

781-676-2510

Europe, Israel, and Africa

+31 (0)20 4546 200

+31 (0)20 4546 202

North Asia Pacific
(Mainland China,
Hong Kong, Taiwan)

+852 2143 6382

+852 2143 6018

Korea

+82 2 556 9420

+82 2 556 9426

South Asia Pacific Australia,

New Zealand, Malaysia,
Singapore, Indonesia,
Thailand, The Philippines,
Vietnam, Guam and India

+61-2-9419-0111

+61-2-9419 0123

Japan

+81 3 5423 3611

+81 3 5423 3622
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Email addresses for license support are listed in the following table.

Table 11 License Support Email

Region

Email Address

Americas

lic_americas@rational.com

Europe, Israel, and Africa

lic_europe@rational.com

North Asia PacificMainland China,
Hong Kong, Taiwan, and Korea

lic_apac@rational.com

South Asia Pacific Australia, New
Zealand, Malaysia, Singapore,
Indonesia, Thailand, The Philippines,
Vietnam, Guam and India

lic_apac@rational.com

Japan

lic_japan@rational.com
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